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DRAGON Summary Sheet






GETTING STARTED
· For best results, creating a user profile should be done in your “normal” environment, with the same background noise as when you will be dictating. Recognition accuracy can sometimes be affected by the presence of air conditioners, fax machines, printers… 

· Version 10 of Dragon contains special acoustic models for a number of “accents” heard in the US (this is particularly important for natives of the UK or of the Indian sub-continent). When creating a user profile, you will be able to choose an “Accent”; if unsure, just pick the “General” accent. 

· When creating a user profile, Dragon presents you with a list of dictation sources. If you are not using the default (microphone plugged into the Mic-In jack), be sure to indicate your device’s type: for instance, USB Microphone or Bluetooth Microphone. (The Help provides details on using special dictation sources, including digital recorders.) 

· If you already have a user profile and want to use an additional dictation source, add a source instead of creating a separate profile for the new device (use the Open User dialog’s Source button.) That way, the same Vocabulary will be used — and refined — whether you are using your USB microphone, Bluetooth microphone, digital recorder, etc.; remember, ongoing vocabulary personalization is one of the keys to getting productivity and convenience in speech recognition! 

· Position the microphone carefully and consistently every time you use it. If you notice the accuracy decreasing, it might be because the microphone has moved out of position. 
· Keep the microphone about a thumb’s width away from the corner of your mouth, not directly in front of it. It should not touch your skin, lips, or hair. Experiment with the best distance for your particular situation, and gently bend the headset’s “boom” if necessary in order to have the microphone in the right place. 

· Noise-canceling microphones only listen on one side. Check that the listening side (often marked by a dot or the word TALK) is parallel to your face and not tilted up or down. 

· If you want to test your microphone independently of Dragon, you can use the operating system’s Sound Recorder — accessible from the Windows Start menu > Programs > Accessories. 

· If your microphone model has a mute switch, make sure it is in the ON position before you start to speak. 

· When you read a text for Dragon’s acoustic training (whether when you first “enroll”, or later, if you wish to boost accuracy), Dragon learns how you sound when you dictate; using the same tone, pace, and volume you are likely to use will help it recognize your future dictations most accurately. 

· At the end of the profile-creation process, Dragon offers to optimize the Vocabulary, presenting a screen entitled “Adapt to your writing style”. Feel free to skip this simplified customization; as soon as your profile is created, you can use more powerful, targeted customization tools. 

· You can access Dragon’s Help topics at any time, from the Help menu, or by saying “give me help” for instance. 

· Pressing a key or two is usually quicker than moving and clicking the mouse (and physically easier, too). Software programs, including operating systems, typically contain keyboard shortcuts, or ‘hot keys’. Dragon includes hot keys for controlling the state of its listening. The numeric keypad’s plus (+) key turns the microphone on or off. Change this default if your computer does not have a numeric keypad, or you wish to keep the plus key for other use. (Dragon’s hot keys can be seen and changed in Dragon’s Options dialog.) 

· If you wish to stop a recognition in progress (for instance, because you didn’t realize the microphone was on before you started to speak to someone, and now Dragon is working to recognize all the sounds it heard), click the red dot shown in the top left corner of the Results box. This will tell Dragon to stop trying to recognize, and turn the microphone off. 

· Including punctuation in your text isn’t just important for readability, it also makes a difference in the accuracy of the transcription. This is because, to best guess what exactly it should transcribe, Dragon NaturallySpeaking uses statistical information about what pieces of the English language often appear next to each other — that’s why short or isolated words are harder to recognize than longer phrases. Punctuation is part of the statistical “context” Dragon uses. When you start using Dragon, you may find that you often forget to say some punctuation marks. Dragon can help you by automatically inserting periods and commas when it guesses they are needed. To turn on this feature (sometimes referred to as “Natural Punctuation”), you can say “Auto punctuation on”, or, from the Tools menu of the DragonBar, choose Formatting — this opens the Formatting options dialog, where you can say “automatically add commas and periods.” 
Formatting and corrections

· You can change the font properties of your text by saying, for example, “Set font Arial,” “Set font Times 12 points,” or “Set font Arial 14 points bold.” Changes are applied to the selected text or text you dictate from then on. 

· You can change the very last phrase you spoke by saying “bold that,” “cap that,” “correct that,” and so on; you do not have to select the text first. 

· To remove a trailing space after a word, you can say, “delete previous character.” 

· To clear (deselect) your last selection, say “unselect that.” 

· To make correcting mistakes easier, Dragon records your speech as you dictate. You can play back a particular line, paragraph, or selection, or the whole document if you want to hear what you said. Select “Play That Back” from the Sound menu of the DragonBar. You can choose to always play back recorded speech in the Corrections menu. Set this option on the Correction tab of the Options dialog box. 

· If the wrong instance of a word or phrase is selected while you are trying to select text by voice, say “select again” until the right one is selected. 

· You can correct a misrecognized word or phrase by selecting it and saying “spell that” followed by several or all the letters of the correct word. This will open the Spell dialog box. 
· When you use “spell that” to spell a word or when you spell in the Spell dialog box, you can say all the characters of the standard Windows character set without pausing. 

· To spell multiple words in the Spell dialog box, spell each of them separately and say “spacebar” to insert a word break. 
· When spelling, you can capitalize a letter by saying “cap” before you say the letter. 
· In the Spell dialog box, you can edit a choice that is almost correct. Say “select 3,” for example, then edit the text using the Spell dialog box commands or the keyboard. 

· You can insert any unknown word into your document by spelling it. Say “spell” followed by the letters of the word or phrase you want to insert. You do not need to pause between saying “spell” and the letters. Dragon NaturallySpeaking actually understands you better if you spell naturally and continuously, rather than one letter at a time. 

· If you select a misrecognized word and the correct word is not on the Correction menu, you can say “spell that” to open the Spell dialog box and then spell the word. 

· You can press the minus (-) key on the numeric keypad to open the Correction menu. Pressing this key is the same as saying “Correct that.” 

· While the Correction menu is open, you can press the Right Arrow key to select the next word or phrase to correct. 

· You can select punctuation by voice. For example, you can say “Select Dear Mom comma.” 

· Select the Show Extras checkbox on the View tab of the Options dialog box to display the Extras tools on the DragonBar when you first start Dragon NaturallySpeaking. 

Voice commands
· For Dragon to recognize any command, there must be a brief silence before and after the command, but none within, otherwise the program cannot recognize the command and instead transcribes the words. For example, make sure you say the words “delete previous 5 words” together in a natural flow, not “delete previous… 5 words”. 

· When you say a command, the Results box gets a thick blue border to indicate that Dragon understands what you said as a command and not dictation. (The exceptions to this are commands such as “new line,” “new paragraph,” or “all caps,” which you normally say in the process of dictating, without pausing. These “dictation commands” are visible in the Vocabulary Editor.) 

· To erase your last “utterance” (what you said since your last silence, whether it was a very long phrase or just one punctuation mark), say “scratch that.” You can repeat “scratch that” to erase a sequence of phrases. It’s often helpful to say “scratch that [x] times,” where [x] is the number of phrases. 

· To undo an action, you can say “undo that.” 

· Dragon lets you “voice-press” any key on your keyboard. Just say press or type followed by the name of the key(s): any letter or number, but also Home, Enter, Tab, Caps Lock, F2, Control, Alt, Shift... 

· To “voice-press” the Tab key, you can say “Tab”, or “Tab Key” or “press Tab.” 

· Want to find a command? Use the Command Browser. Say “open Command Browser” or click Command Browser on the DragonBar Tools menu. The Filter button lets you find commands whose name contains the word or words you specify—even custom commands that you have created. 

· Say “show Sample Commands” or “what can I say” to see a sample list of commands you can say in the active program (Internet Explorer, for instance). 

· You can copy the content of a document (or edit field) to another window by saying “copy all to clipboard” and then switching applications and saying “paste that.” 

· You can use your voice to “click on” the menus, buttons, checkboxes, tabs and other interface elements of most Windows applications. The principle is “Say What You See.” For example “File,” “Save,” “OK,” This is very convenient; however, as a result, if you dictate, in isolation, a word that is also a clickable label, Dragon will interpret it as a command (opening the File menu, for instance, when you just meant to dictate the word “file”. To avoid this, you can set Dragon to “Require Click” option, so that it will not recognize the names of menus and controls as commands unless you say “click” just before—see the Command tab of Dragon’s Options dialog. 

· To close an open menu, you can just say cancel or press Escape. 

· When accessing a submenu, pause briefly after the name of the menu. For instance, to see the available toolbars in applications like Word 2003, you can say View (pause) Toolbars, and to save a file under a certain name, you can say File (pause) Save As. 

· To open the Windows Start menu, say click Start or click Start menu (this and other menus can be navigated by voice, as you will see). 

· You use your voice to open any item you see on your desktop (including files and folders): just say open followed by its name. For instance, to open an item called “winter projects”, you could say open winter projects. (You may want to make sure the items have names that are easy to pronounce.) 

· To start a program by voice, say start (or open) immediately followed by the name of the application. For instance, start DragonPad, start Notepad or start Calculator. But do you need to say "start Word", "start Microsoft Word" or "start Microsoft Office Word 2007"? In the Start Menu, see how the name of the desired program is listed (some programs require clicking a series of submenus.) Whatever the final submenu is called is the name Dragon may expect. If you find the listed name inconvenient, you can create a shortcut to the application and rename that shortcut to something easy; you can now also use the easier name to open the application. 

· To minimize an active window, say click minimize or minimize window (the window remains on your screen, minimized as a taskbar icon). To maximize (enlarge to fit the screen) an active window, say click maximize. 

· To switch between open windows, say “switch to previous window,” and “switch to next window,” or “switch to [window name]” (e.g., “Switch to Internet Explorer”). 

Improving accuracy

· The Accuracy Center provides “one-stop shopping” for all the tools you can use to improve your accuracy and add words to your vocabulary. Say “display Accuracy Center” or click Accuracy Center on the DragonBar Tools menu. 

· If you are not sure which of the Dragon NaturallySpeaking tools you need to use, let the Accuracy Center help you. With the Accuracy Center open, click or say “which tool should I use?” to start the Accuracy Assistant. 

· The best way to improve recognition accuracy is to speak clearly and enunciate each word. You do not have to speak loudly or slowly, just avoid mumbling or slurring your words. 

· You can optimize recognition accuracy by speaking in long, well-enunciated phrases or sentences. Speaking slowly and deliberately, in short phrases or single words, can actually result in more recognition errors. Longer phrases provide more context, which helps Dragon NaturallySpeaking recognize individual words. 

· If a particular word is regularly misrecognized or you want to give the word an alternate pronunciation, use the Training dialog box to train it. To open the Training dialog box say “train words” or click Train on the DragonBar Words menu. 

· If you change audio hardware or move to another location, you should run the Audio Setup Wizard again. You do not have to create a new user. To open the Audio Setup Wizard, open the Accuracy Center and either click or say “check your audio settings.” 

· Use the Increase Accuracy from Email tool to add the names of your email contacts and to teach Dragon NaturallySpeaking about your personal writing style and vocabulary by analyzing your sent email messages. This can significantly improve recognition accuracy. This tool is in the Accuracy Center. Say “display Accuracy Center” and then say “increase accuracy from email.” 

· A good way to find out whether or not a word is in the active vocabulary is to type it in the Vocabulary Editor. (Say “Open Vocabulary Editor” or click View/Edit on the DragonBar Words menu.) If the word appears in the list, it is already in vocabulary; if it does not appear, you can click the Add button to add it. 

· You can view only the words you added to the vocabulary by saying “Open Vocabulary Editor” or clicking View/Edit it on the DragonBar Words menu and then selecting Show Custom Words Only from the Display list in the Vocabulary Editor. 

· When you correct a misrecognized word, the program is less likely to misrecognize that word in the future. 

· You can improve recognition accuracy by adding multiple-word phrases with unusual capitalization (e.g., “The Mayberry Tribune”) to your vocabulary. Say “add new word” or click New on the DragonBar Words menu. 

· You can see a list of the last few recognition results. Say “view Recognition History” or click View Recognition History on the DragonBar Words menu. 

· Run a spelling check on your documents before processing them in the “Add Words from Your Documents” dialog box. This prevents misspelled words from being added to your vocabulary. 

· You can create a Spoken Form for words you prefer not to say aloud. For example, you can create a text command that types “781-555-1212” whenever you say “my phone number.” 

· It is normal for words in the Results box to change sometimes while you are dictating. Dragon may better recognize what you said after you complete a phrase or sentence. 
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